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Nyheter

Nyheter i version 5.3 for programvaran Tl Connect™ CE
Tl CE-paketfil — anvdnd en datorfil for att uppdatera din CE-raknare!

Uppdatera din(a) anslutna CE-raknare med ett steg med hjalp av Tl Connect™ CE och
nya Tl CE-paketet hamtat fran education.ti.com. Detta &r ett alternativt satt att
uppdatera din rdknare med ett steg.

Se mer

Programeditor
HUB- meny for Tl-Innovator™ och Tl-Innovator™ Rover

Programredigeraren stoder HUB-menyn for Tl-Innovator™ for Tl-Innovator™ och TI-
Innovator™ Rover-kommandon. HUB-menyn finns i programmenyn i katalogtradet.

Se mer

Nytt kommando

e styckvis-kommandot (piecewise) har lagts till katalogtradet for Tl Connect™ CE i
Math>MA och aven i katalogen. Detta kommando stoder ny mall for plottning av
styckvisa funktioner i CE OS 5.3.

For mer information om nya och uppdaterade kommandon, ga till referensguiden for
TI-84 Plus CE-T pa education.ti.com/go/download.
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Introduktion till TI Connect™ CE-programvaran

Med TI Connect™ CE-programvaran kan du snabbt och latt utbyta information mellan
din grafraknare och din dator.

Stoder alla Tl grafraknare-8x familj med USB-port, vilket inkluderar:
e TI-84 Plus CE

e TI-84 Plus CE-T

e TI 84 Plus CSilver Edition

e TI-84 Plus

e TI-84PlusT

e TI-83 Premium CE

e TI-83 Plus.fr

e TI-82 Advanced

Anmirkning: Anvind Tl Connect 4.0 som stoéder raknare med endast en I/O-port:
e TI-83 Plus

e TI-89 Titanium

e Voyage 200

e TI-73 Explorer
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Anvanda Tl Connect™ CE Software

Tl Connect™ CE Software innehaller verktyg som du kan anvdnda for att utbyta
information mellan din rdknare och din dator.

Tl Connect™ CE-programvaran har tre arbetsomraden:

Screen Capture (Infanga skarmbild): har kan du hantera infangade skarmbilder.
Calculator Explorer (Raknarutforskare): har kan du hantera raknarens innehall.

Program Editor (Programeditor): har kan du hantera Tl grundldggande program.

£ TIConnect™ CE 8 %

File Edit View Actions Help

(0] CONNECTED CALC... (1) [8]
T1-84 Plu... "
0552
CALCULATOR
EXPLORER
[}
am

PROGRAM
EDITOR

Press [8] to capture calculator screens

Anvénda Tl Connect™ CE Software
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Omrdden i Tl Connect™ CE Software

£2 T Connect™ CE

(0] CONNECTED CALC... (1) [8]
© 1184 PI
-84 Plu...
0552 m
CALCULATOR
EXPLORER
L]
am
PROGRAM
EDITOR
: Press [8] to capture calculator screens

o Menyrad - Anvand dessa menyer for att hantera raknarfiler och skarmar for
att visa raknarinformation och for att fa hjalp.

File Edit Wiew Actions Help

Verktygsfalt - Anvand dessa ikoner for att hantera datorfiler och skdrmar.

=] O @ [ 100%

9 Arbetsomradespanel - Anvand denna panel for att vélja arbetsomraden (Screen
Capture (Infanga skdarmbild), Calculator Explorer (Réknarutforskare) och
Program Editor (Programeditor)).

O]
SCREEN
CAPTURE

0

CALCULATOR
EXPLORER

| ]
L L}
PROGRAM
EDITOR

e Riknarlistpanel - Anvand denna lista for att visa alla anslutna réknare och
vdlja en raknare for visning.
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CONMECTED CALCULATORS (1)

TI-84 Plus CE - 1B29

0550

Innehallspanel - Anvand denna panel for att visa och hantera raknarfiler och
skdrmar i anslutna réknare.

2 TI Connect™ CE

File Edit

CALCULATOR
EXPLORER

(]
(1]
PROGRAM
EDITOR

View Actions Help

CONNECTED CALC... (1 [8]

TI-84 Plu...
@

*Capture 1

Anmirkning: Du kan utféra de flesta atgarder pa dessa menyer genom att dra

och sldppa poster till din anslutna raknare eller dator.

Anvénda Tl Connect™ CE Software
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Anvinda arbetsomradet Screen Capture (Infanga
skarmbild)

| arbetsomradet Screen Capture kan du hantera infangade skarmbilder.

£2 T Connect™ CE = | B |

File Edit View Actions Help

@ CONNECTED CALC... (1) @ NORMAL FLOAT AUTO REAL RADIAN MF n
TI-84 Plu...
0552 m
CALCULATOR
EXPLORER
[]
(T}

PROGRAM
EDITOR

“Capture 2 x

NORMAL FLOAT AUTO REAL RADIAN MP n
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Delar av Screen (Infanga skérmbild) Arbetsyta

Menyrad - Anvand dessa menyer for att hantera filer och bilder, visa raknarinformation
och for att fa hjalp.

File Edit View Actions Help

Anmirkning: Du kan utfora de flesta atgarder pa dessa menyer genom att dra och
slappa poster fran Innehallspanelen.

Verktygsfilt - Klicka pa dessa ikoner for att spara, skicka, kopiera, ta bort och andra
storleken pa filer.

[ 100%

Spara en fil till datorn.

Skicka en fil till en raknare.

Kopiera en fil.

Ta bort en fil.

Lagg till och ta bort en ram runt alla skarmbilder.

Andra storlek p& alla skarmbilder.

QP00 OOe

Visa skarmbildens storlek.

Innehallspanel - Visa skarmbilder i Innehallspanelen.

*Capture 1 x

1]

FLOAT AUTO REAL RADIAN HP

NORMAL

Infdnga och anvénda skéirmar

Fran arbetsomradet Screen Capture (Infanga skdarmbild) kan du infanga och visa
skdrmar fran din réknare.

Innan du borjar

Anslut raknaren till datorn och se till att den visas i Rdknarens lista Panelen.
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Infanga skarmbilder fran raknare

1. larbetsomradespanelen foér Tl Connect™ CE Software, klicka pa arbetsomradet
Screen Capture (Infanga skarmbild).

2. Visa skarmen pa den rdaknare som du vill infanga.

3. Klicka pa intill 6nskad raknare i Calculator List Panel (Rdknarlistpanel).

e Om mer an en raknare ar ansluten, klicka pa bredvid an CONNECTED
CALCULATORS (Anslutna raknare) for att infanga skdarmar fran alla réknare.

Spara riknarskérmar som filer

Fran arbetsomradet Screen Capture (Infanga skarmbild) kan du spara infangade eller
befintliga bilder fran din raknare som en PNG-fil.

*Capture 1 x

1]

NORHAL

FLOAT AUTO REAL RADIAN HP

Anmadrkning: Asterisken i borjan av ett bildnamn indikerar att bilden inte har sparats.
Spara en befintlig skarm

1. Klicka pa den infangade skdrmen i Innehallspanelen.

2. Klicka pa [E].

For att spara flera skdarmbilder

1. Klicka pa Edit > Select All (Redigera > Vilj alla).

2. Klicka pa [El.

Andra namn p3 en skirmbild

1. Placera markoren i borjan av skairmnamnfaltet.
Exempel: Capture 1 (Skdrmbild 1).

2. Dubbelklicka pa namnet for att valja det.

3. Skrivin ett nytt namn pa datorfilen.

Spara en ny skarmbild som en PNG-fil

1. Klicka pa bilden.

2. Klicka pa [E].

3. Navigera till onskad plats dar bilden ska sparas.
4

Anvand standardfilnamnet eller skriv in ett nytt filnamn.
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5. Klicka pa .

Skicka skarmbilder till anslutna raknare

Funktionen "Screen Capture Only" erbjuder ett satt att ta en skarmbild av en graf pa de
hégupplosande rdaknarna, beskara grafomradet och sedan bara konvertera grafomradet
till en Bakgrundsbild. Markera Graph Area Only for att skapa denna typ av
Bakgrundsbild.

1. Infanga skdrmbilden om du inte redan har gjort detta.

2. Klicka pa skarmbilden for att valja den.

3. Klicka pa

== Send to Calculators l= ® |
FILE NAME: NAME ON CALCULATOR: LOCATION: [T
Capture 1 Imagel ¥ U
|| Graph Area Only

Screen captures and converted image files will be sent as Pic Vars to black and white
calculators
DESTINATION CALCULATORS:
® All Connected Calculators o) Select Calculators
|| Replace existing content with the same name on destination calculators

Cancel Send

® FILE NAME (Filnamn): Detta kan skilja sig fran NAME ON CALCULATOR beroende pa
vilket namn du har gett skarmbilden pa din dator.

e NAME ON CALCULATOR (Raknarens namn): Valj bakgrundsbilden (detta bor vara
standardbilden, men du kan &ndra bakgrundsbildens namn pa denna meny).

Anmiérkning: Skarmbilder och konverterade bildfiler skickas som Pic Vars till i
graskala raknare.

e GRAPH AREA ONLY (Endast grafomrade): | den hogra panelen, valj huruvida du
endast vill skicka grafomradet eller hela skarmen. Nar du skickar en skarmbild
tillbaka till en raknare ar det bast att endast skicka grafomradet.

Beskdra en bild

Anvidnda arbetsomradet Screen Capture (InfGnga skdrmbild) 9



En skdrmbild av grafomradet innehaller helskdarmsbilden av TI-84 Plus CE,
statusfaltet, graframen och grafomradet.

Med Tl Connect™ CE-programvaran kan du beskara bilden till en Graph Area Only-
storlek for att skapa en Background Image Var. Du kan beskdra en skdarm till Graph
Area Only i dialogrutan Send to Calculators (Skicka till rdknare).

W77

LT

.| Graph Area Only

e DESTINATION CALCULATORS (Mottagande raknare): Valj huruvida du vill skicka
bilden till alla anslutna réknare eller till endast valda rdaknare (fran en checklista).

Skicka filer till flera raknare

1. Valj knappen Select Calculators (Valj raknare) i dialogrutan.
2. Markera rutorna intill de raknare som du vill vélja.

3. Klicka pa Send (Skicka).

Dra och sldppa infangade skéirmar till datorapplikationer

Fran arbetsomradet Screen Capture (Infanga skdrmbild) kan du dra och sldppa
infangade skarmar till manga datorapplikationer. Med denna funktion kan du anvanda
raknarskarmar i dina dokument.

Dra och slappa skdrmar i datorapplikationer
1. Oppna eller infdnga skirmen.

2. Dra och sldapp skarmen till ett 6ppet dokument eller en datorprogramapplikation.

Obs: Du kan ocksa anvanda Redigera> Kopiera> Klistra in i ett 6ppet dokument eller
presentator datorprogrammet .

10 Anvinda arbetsomrddet Screen Capture (Infanga skdrmbild)



Anvinda arbetsomradet Calculator Explorer
(Raknarutforskare)

Fran arbetsomradet Calculator Explorer kan du hantera rdaknarens innehall.

2 T Connect™ CE = B %

File Edit Vie ctions  Help

(O] CONNECTED CALCULATORS (1) TI-84 Plus CE Archive: 2,096 kB available | RAM: 152 kB available
SCREEN
CAPTURE TI-84 Plus CE - 122 NAME TYPE SIZE LOCATION +

o552 o WU Program 28 RAM
jo oo YY Program a8 RAM
oo YYY Program 28 RAM
{1 u Real List 28 RAM
u {1 L Real List 2B RAM
PROGRAM 1 L Real List 28 RAM
i 3 L Real List 28 RAM
[ Real List 28 RAM
{4 L Real List 28 RAM
foN ThiSet Table Setup 208 RAM
1N RelWindw User Zoom Recall Window 209 B RAM
1N Window Window 2108 RAM

[ celsheet Flash Application 123 kB Archive

@ conics Flash Application 4248 Archive

[@ Deutsch Flash Application a5k8 Archive

@ easyData Flash Application 167 k8 Archive

@ erors Flash Application 1kB Archive

[ Espafiol Flash Application 45k8 Archive

Anvinda arbetsomradet Calculator Explorer (Réknarutforskare)
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Delar av Calculator Explorer (Réknarutforskare) Huvud arbetsyta

Menyrad - Anvand dessa menyer for att hantera filer och bilder, visa raknarinformation
och for att fa hjalp.

File Edit View Actions Help

Anmirkning: Du kan utfora de flesta atgarder pa dessa menyer genom att dra och
slappa poster fran Innehallspanelen.

Verktygsfilt - Klicka pa dessa ikoner for att lagga till, dverfora eller ta bort filer fran din
raknare.

= C
0066 0 6

Lagg till innehall fran din dator.

Skicka valt innehall till din dator.

@ Skicka valt innehall till en annan ansluten raknare.
e Ta bort den valda filen.

@ Uppdatera vyn av en ansluten rdknares innehall.

Innehallspanel - Valj filer som du vill hantera fran denna panel.

12 Anvinda arbetsomrddet Calculator Explorer (Rdknarutforskare)



2 T Connect™ CE =B 8
File Edit View Actions Help
0] CONNECTED CALCULATORS (1) TL84PlusCE  Archive: 2,006 kB available | RAM: 152 kB available
SCREEN
CAPTURE L e - 1202 NaME e size LocaTIoN "
EEz oo WU Program 28 RAM
jo) oo oYY Program 48 RAM
5 o Y Program 28 RAM
[ Real List 28 RAM
o [ Real List 28 RAM
(1]
PROGRAM [N Real List 28 RAM
) L Real List 28 RAM
[ Real List 28 RAM
[ Real List 28 RAM
TN Thlset Table Setup 208 RAM
1N RelWindw User Zoom Recall Window 209 8 RAM
TN Window Window 2108 RAM
@ Celsheet Flash Application 12348 Archive
@ Cconics Flash Application 4248 Archive
@ Deutsch Flash Application 45kB Archive
@ EasyData Flash Application 167 kB Archive
@ emors Flash Application 1kB Archive
@ Espaiiol Flash Application asks Archive

Viilja en ansluten réiknare

Med Tl Connect™ CE-programvaran kan du ansluta flera raknare samtidigt. Klicka pa
den rdknare som du vill arbeta med for att vdlja den. Den valda raknaren blir
standardraknare for alla atgarder i TI Connect™ CE-programvaran.

Innan du borjar

Anslut raknaren till datorn och se till att den visas i Raknarens lista Panelen.
Kopiera riknarfiler till datorn

Du kan kopiera de flesta data, filer och program fran din raknare till din dator som en
"innehalls-backup", for att skicka denna till andra réknare eller for att frigéra minne i
raknaren.

Kopiera en fil fran riknaren till datorn

1. Klicka pa filnamnet for att valja det.

2. Dra ochslapp fileni en mapp i din dator eller pa ditt skrivbord.
For att kopiera en fil fran rdknaren till datorn som ett innehall backup
1. Vilj Redigera

2. Viljalla

3. Dra och slapp filen i en mapp pa datorn eller pa skrivbordet.

Obs: Det finns ingen automatisk backup funktion har.

Varning: Koppla inte loss kabeln under en éverforing.

Anvinda arbetsomradet Calculator Explorer (Réknarutforskare)
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Kopiera en fil fran datorn till riknaren
1. Navigera till 6nskad fil i din dator.

2. Dra filen till Raknarlistpanelen och hall den 6ver 6nskad raknare.

+ Copy
4, Vilj ett filnamn pa rullgardinsmenyn. Detta blir filens namn i din raknare.
5. Klicka pa Send (Skicka).

3. Slapp musknappen nar du ser

Skicka filer till anslutna riknare

Du kan skicka filer till raknare som &r anslutna till TI Connect™ CE-programvaran.

|Varning: Koppla inte loss kabeln under en 6verforing.

Skicka filer till anslutna raknare

1. Klicka pa filen (s) i innehallspanelen for att vélja den.

"]
2. Klicka pa .

=2 Send to Calculators == X
FILE NAME: NAME ON CALCULATOR: LOCATION:
KALSCOPE 8xp KALSCOPE B RAM B
DESTINATION CALCULATORS:
) All Connected Calculators ®) Select Calculators

| TI-84 Plus CE-1B89

| Replace existing content with the same name on destination calculators

CANCEL SEND

e DESTINATION CALCULATORS (Mottagande raknare): Valj huruvida du vill skicka filen
till alla anslutna raknare eller till endast valda réaknare (fran en checklista).

14 Anvinda arbetsomrddet Calculator Explorer (Rdknarutforskare)



Skicka filer till valda raknare

1. Vilj knappen Select Calculators (Valj raknare) i dialogrutan.
2. Markera rutorna intill de raknare som du vill vilja.

3. Klicka pa Send (Skicka).

Konvertera och skicka bakgrundsbilder

TI-84 Plus CE kan visa bakgrundsbilder och Pic Vars. Dessa variabler visas i
grafomradet.

Anmérkning: All information om bakgrundsbilder géller ocksa TI-84 Plus C Silver Edition
och TI-83 Premium CE.

Arbeta med bakgrundsbilder

Tl Connect™ CE-programvaran konverterar automatiskt en bild du skickar till en
ansluten raknare till en Background Image Var. Din bild kan visas pa ett annat satt an
du forvantar dig pa grund av konverteringen till pixeldimensionerna 83 x 133.

Anmdrkning: For basta resultat, redigera din bild sa att den ar proportionell med 83
x 133 pixlar fore konvertering till 83 x 133 pixlar.

Konverteringen till Background Image Var anvander 16-bitars farg.

Du kan ocksa ladda upp en Background Image Var till emulatorvyn i TI-84 Plus CE i TI-
SmartView™ CE-programvaran.

Hos TI-84 Plus CE visas en Background Image Var som bakgrund endast i grafomradet.
En bakgrundsbild visas som skalad for MODE-skdarminstallningarna Full, Horisontell och
Graf-Tabell. Detta bevarar eventuell matematisk modellering som utforts pa en
bakgrundsbild. Du kan inte redigera en bakgrundsbild medan du arbetar med

TI-84 Plus CE. Bakgrundsbilder kors fran och lagras i Arkivminnet.

Anvédnda arbetsomrddet Calculator Explorer (Raknarutforskare) 15



Skicka en bakgrundsbild till en ansluten riknare
Du kan skicka en bakgrundsbild och visa den i grafomradet hos TI-84 Plus CE.

Obs: All information om bakgrundsbilder galler daven for TI-84 Plus CE-T, TI-84 Plus C
Silver Edition och TI-83 Premium CE.

NORMAL FLOAT AUTO REAL RADIAN HP l]

Oppna Tl Connect™ CE-programvaran.

Vilj arbetsomradet Calculator Explorer (Utforska raknare).
Anslut TI-84 Plus CE till datorn med kabeln.

Satt pa TI-84 Plus CE.

Vilj den bild som du vill konvertera.

Dra bilden till Raknarlistpanelen och hall den 6ver 6nskad raknare.

Slapp musknappen nar du ser & Copy |

® N O Uk W DNPR

Vilj ett bildnamn pa rullgardinsmenyn (Image0O - Image9). Detta ar bildens namn
hos TI-84 Plus CE.

Anmdrkning: Bildnamnet du viljer blir bildnamnet hos din rdknare. Notera detta
bildnamn (eller gor det till en del av filnamnet i din dator) for identifiering nar du
vill skicka eller dela denna fil.

VARNING: Férladdade bilder lagras i Imagel - Image5. Anvdnd andra Image-
nummer for att undvika 6verskrivning av de forladdade bilderna.

9. Klicka pa Send (Skicka).

Obs: Andra namnet pa datorfilen s& att du kan identifiera din Image Var senare (bro,
fontan, etc.). Raknarens interna Image#-variabelnamn andras inte.

Obs: For att spara bakgrundsbilden till din dator, dra bilden fran Calculator Explorer
(Utforska raknare) till ditt skrivbord eller till mappen dar du vill spara den.

e For att visa din nya bakgrundsbild i grafomradet hos TI-84 Plus CE, tryck pa
[FORMAT], &ndra instillningen av Background (Bakgrund) till bilden som du precis
har skickat till raknaren (till exempel Image5) och tryck pa (GRAPH].
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Anmirkning: Fran raknarens grafskarm kan du ocksa @ndra Bakgrunden med det
interaktiva kommandot [draw], BACKGROUND, 1:BackgroundOn.

Dataimport

Med funktionen Dataimport kan du konvertera/skicka kalkylprogramsdata sparade som
csv-datafiler till raknaren som rdknarlistor eller matrisfiler.

Du kan ta fram funktionen Dataimport fran arbetsomradet Calculator Explorer
(Raknarutforskare).

Viktiga funktioner:
e Skapa (eller ladda ned) ett kalkylark med data.

e Fore import, redigera data i din kalkylprogramvara for att endast tillata numeriska
raknarformat (specificeras nedan) for import till en raknarfil.

Om kalkylprogrammet

e Endast ett kalkylprogram sparat som en CSV-fil (Comma Delimited) (*.csv) kommer
att importeras at gangen via arbetsomradet Calculator Explorer.

e En kalkylprogramfil (csv) kan dras till Calculator Explorer eller importeras via
menyn Actions > Import Data (.csv) to Lists/Matrix....

e Upp till 6 réknarlistor eller 1 matris fran kalkylprogramsdata kommer att skickas till
den anslutna raknaren.

Regler for att forbereda kalkylprogrammet for import:

e Alla celler maste innehalla Reella Tal-data som de upplevs pa raknaren och ingen
text.

- Komplexa tal stods inte for dataimport.
e Data maste starta i cell Al

e Listimport: Om rdknarlistor 6nskas:

%2 Import your Data [= El|

Prior to importing your spreadsheet saved in csv file format, make
sure your data starts in cell A1, contains only Real numeric values,
and does not contain text.

Select calculator file type for conversion:

FILENAME: 08 compaes_clean_matrix or list.csv
COLUMNS:

£} Lists ~ 1 v

CANCEL CONTINUE

- endast sex kalkylprogramskolumner, A-F, kommer att importeras
- Kolumner kan ha en langd pa upp till 999 celler.

- Den forsta tomma cellen i en kolumn tolkas som slutet pa data for den
listimporten

Anvédnda arbetsomrddet Calculator Explorer (Raknarutforskare) 17



e Matrisimport: om raknarmatris 6nskas:

@

Prior to importing your spreadsheet saved in csv file format, make
sure your data starts in cell A1, contains only Real numeric values,
and does not contain text

Select calculator file type for conversion:

FILENAME: 01 testcsv

ROW: coL: CELLS:
[i::] Matrix v 2/ x 2 4
Up 0400 cell
CANCEL CONTINUE

- Endast en matris kan importeras fran en kalkylprogramsfil.

- Upp till 400 celler kan importeras. (Exempel: rad x kol: 10 x 5 = 50 celler fran
radomrade 1-10, kolumner A-E.)

- Matrisens dimension i formen (rad x kolumn) kommer att begéras under
importforloppet i Calculator Explorer.

- Entom cell inom den specificerade matrisdimensionen kommer att tolkas som
0.

* Ha inte data i kalkylprogrammet utanfor de tillatna storlekarna for listor eller
matriser enligt ovanstaende beskrivning. Annars blir filen ogiltig nar du férsoker
med en dataimport till Calculator Explorer.

Spara raknarlistor eller matrisfiler

e For att spara skapade raknarfiler till datorn, efter import/sandning till raknare, dra
list- eller matrisfilen fran Calculator Explorer till 6nskad datorplats.

Ta bort riknarfiler
Du kan ta bort data, filer och program fran din rdknare.

Ta bort filer fran raknaren

1. Klicka pa filen pa panelen Innehall du vill radera.

2. Tryck pa .
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Anvanda arbetsomradet Program Editor (Programeditor)

| arbetsomradet Program Editor (Programeditor) kan du arbeta med Tl grundldaggande
program.

8 T Connect™ CE (=B [t

File Edit View Actions Help

+ =

SCREEN
CAPTURE

0

New Program
CALCULATOR

EXPLORER

Open Program

-
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Omrdden i arbetsomrdadet Program Editor (Programeditor)

& TIConnect™ CE = | B |

File Edit View Actions Help 1

+ =

SCREEN
CAPTURE

ol

CALCULATOR
EXPLORER

New Program

Open Program

-

o Menyrad - Anvdnd dessa menyer for att hantera filer och program, och for att

fa hjalp.

File Edit Wiew Actions Help

OBS: | arbetsomradet Programeditor kan du bara dra och slappa program

till innehallspanelen.

9 Verktygsfalt - Klicka pd dessa ikoner fér att Skapa nytt program, Oppna
program, Spara program till dator, Skicka program till ansluten/anslutna
riknare, Angra eller Gér om och Skjutreglaget for teckenstorlek.

+ @B 8 © c @ A
0 O (5] (6]

@ Skapa nytt program.

® Oppna program.
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Spara program till dator.

Skicka ett program till ansluten/anslutna réknare.

Angra eller Gér om.

Q0 Qo

Skjutreglage for teckenstorlek for att 6ka eller minska storleken pa
texten i:

e Katalogpanel
e Programeditor

@ Innehallspanel - Anvind denna panel for att skapa, visa och redigera program.

New Program

_|_

Open Program

-

Katalogpanel - Anvand denna panel for att vélja din typ av réknare och vilj
sedan fran katalogtridet (efter kategori) for att skapa program.
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*» Angle

» Catalog

* Char

* Distribution
* Draw

* Finance

* Format
*List

* Math

* Matrix

» Memory

» Mode

* Program

» Statistics
+ Stat Plots
* Table Setup
* Test

* Variables

» Zoom

Syntaxreferenspanel - Anvand denna panel for att visa korrekt syntax for varje
kommando tillsammans med obligatoriska och valfria argument.

Syntax Reference

AsmConp (prgmASM1,pr

Skapa ett nytt program

Nar inga program dr ppna visar Innehallspanelen endast ikonerna Nytt program och
Oppna program.

For att skapa ett nytt program New Program
» Klicka pa ikonen New Program (Nytt

program).
Oppna ett befintligt program Open Program

1. Klicka p& ikonen Open Program (Oppna -—‘
program). -

2. Navigera till 6nskad mapp.

22 Anvidnda arbetsomrdadet Program Editor (Programeditor)



3. Klicka p3 Open (Oppna).
Redigera ett Var Name

Nya programnamn ar PROG##. Numren anges i ordningsfoljd, till exempel: PROGO1,
PROGO2.

Andra ett programnamn

» Klicka inuti rutan Var Name och skriv in ett nytt namn pa upp till 8 bokstaver eller
siffror (forsta tecknet far inte vara en siffra).

VAR NAME:  PROGO1

Skydda ditt program

Med Tl Connect™ CE-programvaran kan du férhindra att ditt program redigeras efter
att programmet har skickats till en ansluten raknare.

For att skydda ditt program

> Klicka pa kryssrutan intill 1asikonen. s
Spara ett program i din dator
Asterisken i borjan av ett programnamn indikerar att programmet inte har sparats.

For att spara ett program

1. Klicka pa .

2. Navigera till 6nskad mapp.
3. Klicka pa Save (Spara).
Stinga ett program

For att stanga ett program

> Klicka pa x:et vid programnamnet.
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Anviéinda Katalogpanelen

Katalogpanelen innehaller en lista 6ver raknarkommandon, funktioner, variabler och
symboler som du kan anvdnda for att skapa program.

Maximera eller minimera en katalogniva

> Klicka pa triangeln vid sidan av varje inmatning i Katalogen.

TI-84 Plus CE w *Untitled1.8xp X -

» Keypad

» Angle VAR NAME:  PROGO7
» Catalog

» Char

» Distribution

» Draw
» Finance
» Format
» List
¥ Math
» Math
» Numeric
» Complex
» Probability
¥ Fraction
I
MEAD
rnld4rUnid
» Matrix
» Menory
» Mode
» Progran
» Statistics
» Stat Plots
» Table Setup
» Test
» Variables
» Zoom

Reference

No reference available

Placera en kataloginmatning i Innehallspanelen

> Dra och sldpp kataloginmatningen i Innehdllspanelen. Detta placerar markoren i
programeditorns kommandorad efter att posten slapps.

- ELLER -

> Dubbelklicka pa kataloginmatningen. Detta klistrar in posten i programeditorn och
fokus forblir pa Katalogpanelen for att markera dnnu en post. Klicka tillbaka i slutet
av kommandoraden for att fortsatta skriva i editorn.
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Sa har undviker du syntaxfel

Anvand katalogen éver kommandon och symboler for att klistra till editorn. Da undviker

du syntaxfel pa grund av felaktig anvandning av versaler och gemener i kommandon.

Exempel:

Skrev du Eval (eller eval(?

Skrev du sin (eller Sin(?

Katalogtradslistan
klistrar in korrekt
versal/gemen- och
mellanrumsformatterin
g.

T1-84 Plus CE

DispGraph
DispTable
PDMS
Dot-Thick
Dot-Thin
DrawF
DrawLlnv
Ds<(

e

e

E

PEFF(
Else

End

Eng

EqurString(

Syntaxfel med extra mellanslag

Kéra ett program pd en riknare

Extra mellanrum kan orsaka syntaxfel nar ett program kors pa raknaren.

VAR NAME:

eval{

) e -

PROGO1

Anvinda arbetsomrddet Program Editor (Programeditor)
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Var finns de extra mellanrummen?
. VARNAME: SNAKE
Du kan se de extra mellanrummen i

ditt program med hjalp av TI Connect™
CE Program Editor genom att markera
hela programmet. Extra mellanrum i
slutet av kommandorader ska tas bort
innan du skickar programmet till
raknaren.

| 2)
A+26( (A=D) - (A=27) ) A
B+10( (B=0) - (B=11

Om det finns extra mellanrum nar programmet kors i rdknaren ska du vilja Goto fran
syntaxfelskarmen. D& hamnar markoren pa den programrad dar felet forekommer.
Kontrollera raden for korrekt syntax och extra mellanrum i slutet av kommandoraden.

VARNAME:  SNAKE

URMAL FLOAT AU
qlpnusnnn LINE 11

TN REAL RADIAN HP

o

ERROR: SYNTAX

:Quit
FHGoto

ClrHome
13+A

548

124X

14P

34D
Xadin(L1)
Xsdin(Lz)

1X>dim(L1)

s Xrdim(L2) FHL,
:F111(B,L1)
:Fill{A,Lz2) / \L2(F)," ")
:Repeat KE45 N : Eff'f?éﬁs A
AsLz2 (P
/ 5 P+1-X(P=X) 4P
Cursor lands on error. ??‘.av(x {24,28,26,34})

A+(D 26)- (D= 24;«»\

( = A-z?))aA
E*Tﬂt(E @)-(B=11))-B

e Flytta markoren till slutet avden kommandoraden.

e Ta forsiktigt bort extra mellanrum.

OBS: Det finns inget angra pa raknaren.
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WORFAL FLOAT AUTO REAL EADIAN HF n HORRAL FLOAT AUTO KEAL RABIAN riF n

PROGRAM : SNAKE

:ClrHome :ClrHome
:12+A :13+A
15+B 1548
1104X P10
1P 1P Spaces
1340 134D
) | Xsdim(Lall i¥edimils)  H
iXrdimilz) s rdimilz}
tFil11(B.L1} tF11liB.L1)

Nar blir kommandona raknarkommandon (token)?

Kommandona blir inte raknarkommandon (token) férran programmet skickas till
raknaren.

Om det ar ett fel nar ditt program skickas till eller kors pa raknaren, kontrollera om
varje kommando i raknarprogrammets redigeringsldge verkligen ar ett kommando-
token.

Hur vet man?

Nar ett kommando ar ett token pa raknaren dar markoren pa det foérsta tecknet och
hoppar sedan éver kommandot som ett token. Om markoren flyttas bokstav for bokstav
genom ett kommando konverteras inte det kommandot. Ta bort och klistra in
kommandot fran raknaren.

. PROGRAM: B PROGRAM: B On the calculator, the cursor
— :EnvBinom( tinvBinom(H

jumps over the “token.”

It only understands the
characters as a function or

command name.

Kom ihdg: Nar du matar in ett program direkt i raknaren klistras kommandot eller
funktionen in fullstdndigt som ett token.

Varning: Vissa raknarkommandon, sdsom LEFT, CENTER, RIGHT och FRAC, &r ord som du
kan anvanda i en strang. Om ett ord som du anvdnder i en strang ar samma som ett
raknarkommando kommer ditt ord att bli ett raknar-token och kan ge fel i ditt program.
Undvik att anvdnda ord eller delar av ord som ar samma som TI-Basic-kommandon. Da
undviker du att oavsiktligt gora ett kommando till ett token.

Varning: Sprakinstallningen i TI Connect™ CE bestdmmer hur texten tolkas som ett
kommando-token for raknaren. Oppning av program och sandning tillbaka till raknaren
med Tl Connect™ CE pa olika sprak kan resultera i:

e oo6nskade kommando-token och/eller
e syntaxfel

Anvéinda Syntaxreferenspanelen

Syntax Reference Panel visar syntaxen for varje inmatning i Katalogen, inklusive
obligatoriska och valfria argument.
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HUB- meny fér TI-Innovator™ och TiI-Innovator™ Rover

Programredigeraren stoder HUB-menyn for Tl-Innovator™ for Tl-Innovator™ och TI-
Innovator™ Rover-kommandon. HUB-menyn finns i programmenyn i katalogtradet.
Detta HUB-menytillagg till programredigeraren for TI Connect™ CE ger samma HUB-
menyupplevelse som nar Appen Hub ldses in pa CE-raknaren. Se till att alltid anvdnda
de senaste versionerna av CE OS och appen CE Hub.

Se dven:
Anvanda Katalogpanelen ¥ Program
Skicka ett program till en # Contro
raknare » Tnput/Output
- r:l—.- ar
* HUE
» Sond|"SET

» Send|"READ
* Settings
Wait
et |
eval
® Rover (RV)...
Send| "CONNECT-Output
# Send[ "CONNECT- Input

k Forts

B Send| "RANGE

» Send | "AVERAGE

# Send| "DISCONMNECT -Output

# Send | "DISCONNECT-Input

*» Hanage

Skicka ett program till en réiknare
Du kan skicka ett program till en ansluten raknare.

For att skicka ett program till en ansluten raknare

1. Spara programmet om du inte redan har gjort detta.

2. Klicka pa .

® FILE NAME (Filnamn): Detta kan skilja sig fran NAME ON CALCULATOR beroende pa
vilket namn du har gett programmet pa din dator.

e NAME ON CALCULATOR (Rdknarens namn): Vélj programnamnet (detta bor vara
standardprogrammet, men du kan dndra programmets namn genom att klicka pa
Custom (Anpassat)).
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=51l E3 Name on Calculator E=IEN ]

FILE NAME: NAHE O CALCULATOR: LocaTION:

Untitled1.8xp PROGOL B RAM

Qustom
DESTINATION CALCULATORS: Custom Program names can be up to & characters in length

All Connected Calculators. ® Select Calculators. The first character can be A-Z or 8.
The remaining characters can be A-Z, 6 or 0-9

M T1-84 Plus CE-ADAD

i Replace existing content with the same name on destination calculators

CANCEL

CANCEL  SEND

e LOCATION (Plats): Valj huruvida du vill spara programmet i rdknarens RAM eller
Archive (Arkiv).

e DESTINATION CALCULATORS (Mottagande raknare): Valj huruvida du vill skicka
programmet till alla anslutna raknare eller till endast valda raknare (fran en
checklista).

Skicka program till flera riknare

1. Vilj knappen Select Calculators (Valj raknare) i dialogrutan.
2. Markera rutorna intill de raknare som du vill valja.

3. Klicka pa Send (Skicka).

Sprakinstallningar

Om du vill utveckla ett TI-Basic-program i ett annat sprak an sprakinstallningen i din
dators OS kan du starta om Tl Connect™ CE i ett annat sprak.

1. Valj File > Change Language.
2. Vilj sprakdndring efter att applikationen har startats om.

=
2 Choose a language |g|

Language changes will take effect after application restart.

English (US) v

QUIT LATER QUIT NOW CANCEL

e QUIT LATER (Avsluta senare) - Behaller det valda spraket och Tl Connect™ CE
startar med detta sprak nasta gang Tl Connect™ CE startas.

e QUIT NOW (Avsluta nu) - Stanger lapp. Tl Connect ™ CE kommer att lanseras i
detta valda spraket nasta gang Tl Connect ™ CE lanseras.

e CANCEL (Avbryt) - Ingen sprakandring. Datorns OS-sprak blir standardinstallning.

Anvinda arbetsomrddet Program Editor (Programeditor)
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Underhalla din raknare

Uppdatera réiknarens operativsystem

Med Tl Connect™ CE-programvaran kan du ladda ned operativsystem for grafraknare.
Innan du borjar

e Séakerhetskopiera dina raknarfiler (RAM, Archive och Apps).

e Se till att din rdknare ar paslagen och ordentligt ansluten till datorn.

e Om du har flera rdknare i samband med USB-kablar dator, kan OS 6verforingar ske
till specifika raknare.

Detta kan goras genom att valja specifika raknare i dialogrutan Send.

Varning: Koppla inte loss kabeln under en 6verforing.

Uppdatera operativsystem hos grafraknare
1. Klicka pa Actions > Send OS (Atgirder > Skicka OS).

2. Navigera till korrekt OS-fil for din raknarmodell som &r lagrad i datorn.
3. Klicka p& Open (Oppna).
Dialogrutan Skicka OS Oppnas.

4. Vilj fran Destination Rdknare:
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DESTINATION CALCULATORS:

All Connected Calculators ®) Select Calculators
o | TI-84 Plus CE-12A2

5. Tryck pa Skicka e

Tl CE-paketfil — anvéind en datofrfil for att uppdatera din CE-
riknare!

Uppdatera din(a) anslutna CE-rdknare med ett steg med hjélp av Tl Connect™ CE och
nya Tl CE-paketet hamtat fran education.ti.com. Ladda alltid ner det senaste Tl CE-
paketet fran education.ti.com.

Anslut din(a) CE-raknare till TI Connect™ CE. Dra det [ampliga Tl CE-paketet till
Calculator Explorer.

e TI-84 Plus CE/CE-T: TI84CEBundle-5.3.0.xxxx.b84
e TI-83 Premium CE: TI83CEBundle-5.3.0.xxxx.b83

Tl Connect™ CE uppdaterar din CE OS, alla CE-appar som behover uppdateras eller
saknas fran din raknare samt laser in de 5 forladdade Image Vars till Imagel — Image5.
Denna process kan inte stoppas sa se till att spara (dra av) alla dina favoritraknarfiler
med hjalp av Tl Connect™ CE Calculator Explorer. Du kan dra dina favoritraknarfiler
tillbaka till raknaren nar processen for det nya Tl CE-paketet ar slutford.

Dra CE-paketet till Calculator Explorer. Vanta tills hela processen avslutas. Dra inte ur
kabeln under nagon filéverforing. Forvanta dig att CE-raknaren startar om innan
overforingen av Image Var och appar. Forvanta dig att CE-rdknaren defragmenterar
(omorganiserar minnet) nagon gang under processen. Meddelanden visas pa Tl
Connect CE-fonstret nar 6verforingen startar.

Obs: Forvaxla inte Tl CE-paketfilen med CE OS och fil fér CE-appar, som fortfarande gar
att laddas ner separat fran education.ti.com. Tl CE-paketet innehaller alla de senaste
filerna som du behdver for att uppdatera och aterstélla din(a) CE-rdknare, precis som
om du precis képt den/dem, och erbjuder ett snabbt satt att uppdatera klassinstallda
CE-rdaknare.

Viktigt: Om det star "Waiting... (Vdntar...)" pa CE-raknarskarmen har raknaren forlorat
0S. Detta kan handa om en kabel dras ur fran raknaren eller datorn under filéverféring.
Ifall den &r ansluten ska du koppla ur de och och sedan ateransluta den till datorn. Dra
CE-paketet till Calculator Explorer.

Kom ihdg: Vanta tills hela processen avslutas. Dra inte ur kabeln under nagon
fildverforing. Forvanta dig att CE-raknaren startar om innan dverforingen av Image Var
och appar. Forvanta dig att CE-raknaren defragmenterar (omorganiserar minnet)
nagon gang under processen. Meddelanden visas pa Tl Connect CE-fénstret nar
Overforingen startar.

Underhdlla din réknare 31


http://education.ti.com/
http://education.ti.com/

Du kan behoéva upprepa denna process och CE-paketet 6verfor filerna igen. Dra inte ur
kabeln under nagon filéverforing.

Se dven:
Uppdatera raknarens operativsystem

Skicka filer till anslutna réknare
Inhdmta ridknarinformation

Tl Connect™ CE-programvaran tillhandahaller information om din raknartyp, produkt-1D,
0S-version, RAM, Arkiv, Sprak, ROM-version och hardvaruversion.

Obs: Calculator Information finns endast fran Calculator Explorer Work Space.
For att visa raknarinformation

> Klicka pa View > Calculator Information (Visa > Raknarinformation).

=4 Calculator Information = P

Calculator: TI-24 Plus CE
Product ID: 13000012A2

————— 0S Version: 5.2.0.3C

RAM: 262 kB (152 kB available]
Archive: 4,194 kB (2,096 kB available)
N Language: ENGLISH

ROM Version: 5.0.0.89

Hardware Version: ©

CLOSE

.

Kompatibilitet med grafriknare

Se handboken TI-84 Plus CE Komma igang for kompatibilitet med grafrdknare. Se dven
handboken TI-83 Premium CE Komma igang.

Anmdrkning: | regel ar grafraknarna T1-84 Plus CE kompatibla med andra TI-84 Plus- och
TI-83 Plus-modeller.
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Appar, operativsystem och vissa datafiler med numeriska typer som ej stods delas inte
mellan modeller.

TI-Basic-program kan behdva modifieras for att korrekt visa hogupplosta
fargskarmsmodeller.
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Allman Information

Texas Instruments support och service

Allman information: Nord- och Sydamerika

Hemsida: education.ti.com
KnowledgeBase och e-postfragor Webb: education.ti.com/support
Telefon: (800) TI-CARES / (800) 842-2737

For Nord- och Sydamerika och
amerikanska territorier

Internationella kontaktuppgifter: education.ti.com/support/worldwide

For teknisk support

Knowledge Base och stod via e-post: education.ti.com/support eller
ti-cares@ti.com
Telefon (ej kostnadsfritt): (972) 917-8324

For produktservice (maskinvara)

Kunder i USA, Kanada, Mexiko och amerikanska territorier: Kontakta alltid Texas
Instruments kundsupport innan du returnerar en produkt for service.

For alla andra ldnder:
For allmdn information

For mer information om Tl-produkter och service, kontakta Tl per e-post eller besok
webbplatsen pa Tl:s Internetadress

E-postfragor: ti-cares@ti.com
Hemsida education.ti.com
Service- och garanti-information

For information om langden och villkoren for garanti, se garantisedeln som medfdljde
denna produkt eller kontakta din lokala Texas Instruments-aterforsaljare/distributér.
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